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Known Issues as of QPS 8.5.1 
Following is a list of known issues in QPS® 8.5.1. 

QPS Server 
 Temporary files created in [drive]:\Windows\Temp\poifiles are not automatically deleted 

and can accumulate to many gigabytes if not manually deleted. (55283) 

 When updating the QPS database, you cannot configure the CreateSectionWorkflows 

setting in the file “UpgradeConfiguration.xml”. (49475) 

Workaround: Use a database script to update the legacy database: 

1. Copy the “Database” folder from the QPS Server installer to the computer where the QPS 
Server database is. 

2. Navigate to Database/[database type]/Update and open the 

“UpgradeConfiguration.xml “ file. 

3. Change the property “CreateSectionWorkflows” to false. 

4. Save and close the file. 

5. Update the database with the update script instead of the update application. This will create 
publication workflows, but no section-level workflows will be created. 

 In order to run Automation Services on a Web site, you must add its port number to the site’s list 
of firewall exceptions. 

 If the QPS Server computer has more than one IP address, you cannot connect to QPS Server 
from JConsole and Script Manager. (39202, 25921) 

 Some saved searches’ criteria may change after you update from QPS 8.1 to QPS 8.5. (59697) 

 If you save a picture that has IPTC information in Photoshop® CS5, and then check it into QPS, 
the IPTC information does not display in QPS. If the file is a JPEG, the following alert may display 
when you try to edit its attributes or check it in: “'There is an error in XML Document (1, 16023)” 
(55973) 

 The Copytasting feature incorrectly displays RTF files containing East Asian characters. (6771) 

 Portions of the Korean and Japanese in QPS Server installer have not been localized. (10986, 
11573) 

QPS Clients 

 Accented and Arabic characters in IPTC attributes display incorrectly in QPS clients. (13252) 

QPS Connect Client 
 (Windows only) Print and Print Preview are disabled for List view, Filmstrip view, and Detailed 

Thumbnails view. (51301) 

Workaround: Use Export Search Results. 
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 The Select All command does not select all assets when used with a search that returns a large 
number of assets. On Windows®, the arrow and Page Up/Page Down keys do not work in search 
results. (47048, 58763) 

Workaround: Open the “QPPCoreConfig.plist” file (Mac OS®) or “QPS Connect Client.exe.config” 

file (Windows) and set LazyLoadingMode to NO_LAZYLOADING. 

 When articles are expanded in the search results pane, their components are included in the 
asset count in the status bar. (52060) 

 (Mac OS only) If you are using Compact view, you cannot use QPS Connect Client to check in, 
cancel checkout of, or edit a picture that is open in Photoshop CS4. (10871) 

Workaround: Use QPS Connect Client in Expanded view and uncheck Open Documents as 
Tabs option in the preferences for Adobe® Photoshop and Illustrator®. 

 The context menu for a library in the Search Results palette erroneously includes the options 
Check Out with Attachments and Index Again. (16694) 

 (Windows 7 only) If you increase display DPI scaling to 125% or 150%, the Read Only button 
does not display in the View Revisions dialog box for a checked-out asset (QPS > View [Asset] 
Revisions). (11918) 

 (Mac OS X 10.6 only) If you try to create a main category or subcategory without modifying the 
default name (Administration pane > Define Content Structures > Main Category or 
Subcategory drop-down menu > Other), the Apply button is not enabled. (13848) 

 (Mac OS X 10.6.0, 10.6.1 only) If you change the system language, Help may not display in the 
correct language. (13830) 

 (Windows only) You cannot check in a picture file that is open in Adobe® Photoshop® CS4 if 
QPS Connect Client is in Compact View. (10809) 
 
Workaround: Use QPS Connect Client in Expanded View only when working with Adobe 
Photoshop CS4 or Adobe Illustrator CS4. 

 (Mac OS only) You cannot use QPS Connect Client to check in, cancel checkout of, or edit a 
picture that is open in Photoshop CS4 if you are using Compact View. (10871) 
 
Workaround: Use QPS Connect Client in Expanded View only and uncheck the Open 
Documents as Tabs option in Adobe Photoshop (Preferences > Interface pane) and Adobe 
Illustrator (Preferences > User Interface pane). 

 (Mac OS only) If you try to check in one of several checked-out picture files that are open in 
Photoshop CS4, all of the files are closed. Also, if you check in an open picture file while its tab is 
not selected in Photoshop CS4, the picture file does not close after check-in. (10899) 
 
Workaround: Uncheck the Open Documents as Tabs option in Adobe Photoshop CS4 
(Preferences > Interface pane) and Adobe Illustrator CS4 (Preferences > User Interface pane). 

 If you use QPS Connect Client Compact View to check in a Word document that has not been 
saved yet, and then click Yes when Word displays a dialog asking if you want to save changes, 
you must manually switch from Word back to QPS Connect Client. (13003) 

 You cannot remove the first row of a search with multiple rows. (4851) 
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 (Windows only) If you click a checked-out picture file’s window in Photoshop CS2 / CS3 / CS4 
and then switch to QPS Connect Client in Compact View, you cannot check in the picture file. 
(6199) 
 
Workaround: Switch to full-screen view and then check the picture in. 

 If a QPS Connect Client administrator specifies vertical story direction as a default for 
subcategory articles, the system ignores the vertical story setting when a QuarkCopyDesk® or 
QPS Web Hub user creates an article with horizontal story direction and tries to save a revision or 
check in the article to a subcategory with the vertical story default setting. (467185) 

 QPS Connect Client administrators cannot specify privileges for individual East Asian formatting 
features in QuarkCopyDesk. (467229) 

 Attribute constraints are not correctly identified under the following conditions. The user checks in 
an asset or saves a revision of an asset with an attribute constraint (for example, the "Require 
Change" constraint for an attribute field that requires changing the value before completing the 
check-in or save-revision process). During the same QPS session, the user checks in (or saves a 
revision of) another QPS asset that does not have a default value but has a constraint applied to 
it. The constrained attributes are not flagged correctly during the check-in or save-revision 
process. (468499) 

QPS XTensions software 

  If you attach pictures to two or more picture boxes on a master page, then select the boxes and 
press Shift+Delete, QuarkXPress® unexpectedly quits. (29840) 

  (Windows 7 only) If you increase display DPI scaling to 125% or 150%, the user interface for 
QPS preferences ([Application Name]/Edit > Preferences > QPS) displays incorrectly, the 
Read Only button does not display in the View Revisions dialog box for a checked-out asset 
(QPS > View [Asset] Revisions), and the OK and Cancel buttons do not display in the Save 
Revision and Check In dialog boxes. (11918, 11919) 

 If you disable the PDF Filter XTensions® module (Utilities > XTensions Manager) in 
QuarkXPress or QuarkCopyDesk, QPS XTensions software will not load. (8035) 

QuarkXPress with QPS XTensions software 
 If a QuarkXPress project that has been created or modified in QPS 8.1 or above includes an 

article with a picture component, QuarkXPress shows Geometry Differs when you check out the 
project for the first time after updating to 8.1.6.2. (This issue does not occur if 

allow.pic.formatting.without.article.checkout = Yes in the 

conf/ServerApp.properties file.) 

Workaround: Update the geometry.  This will not cause text reflow or content loss.  

 If you check out an article with a picture component in QuarkCopyDesk; then check out the 
picture for that component in QuarkXPress, change an attribute such as scaling, and check the 
picture back in; and finally check the article back in from QuarkCopyDesk; the image scaling 
change is lost,  (4087) 

 If you create a picture box on a master page, attach an image, Control-click/right-click the picture 
box and choose Edit Original, edit the picture file, and then update the picture in picture usage 
(Utilities > Usage), a new attachment is created for the updated picture on every page that is 
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derived from this master page. Also, the picture boxes on the derived pages lose their link to the 
picture boxes on the master page. (35120) 

 The QPS > Check In Project with Pictures command is disabled when a master page is active. 
(30011) 
 
Workaround: Navigate to a layout page and then choose this command. 

 QuarkXPress unexpectedly quits if you perform a thumbnail drag of a page with a picture 
attachment from Project A to Project B and then either close Project B, check Project B in, or 
perform a Save As on Project B. For information about thumbnail drags, go to 
http://support.quark.com/knowledgebase/searchknowledgebase.aspx and search for “thumbnail 
drag”. (14720) 

 (Windows only) In a new project, if you create a spot color using one of the supplied color models 
(such as PANTONE, TOYO, and DIC), apply that spot color to text in a text box, and assign the 
text box as an article, the project loses its relationship with the article. As a result, the article does 
not display in the Project Attachments palette and the Attachments tab of the Search Results 
palette, and QuarkXPress may unexpectedly quit when you use QPS features. (31460) 

  If you get a read-only copy of a project template, log off of QPS, and then log back on, an 
“environment conflict” dialog box erroneously displays. (21087) 

 If you replace the geometry of an article with the geometry of an article template, and then try to 
revert to a revision of the project that was saved before the geometry was replaced, QPS displays 
a “problem attachment” dialog box and detaches the article from the layout. (25979) 

 If you drag an article onto a blank part of the page and then cancel the attachment, resources 
from the article (such as style sheets and colors) are nevertheless added to the project. (23653) 

 If you check out an article that contains anchored boxes, then select an anchored box and press 
Shift+Delete, the article is detached. (26580) 

 If you import an EPS file that contains spot colors, check the project in to QPS with pictures, 
check the project back out, and then export the layout in PDF format in Separations mode with 
the Process and Spot output setup, the spot color plates are not generated. (7173) 

 QuarkXPress® may unexpectedly quit if you do the following: (471761) 

1. In QuarkXPress, import a PSD file with layers, hide one of the layers (Window > PSD Import 
> Layers tab), and then assign the picture box as an article. 

2. Check out the article in QuarkCopyDesk. 

3. In QuarkXPress, check out the picture file, make some changes to it, and then check it back 
in. 

4. When the update notification displays in QuarkCopyDesk, click OK, and then save a revision 
of the article. 

5. When the update notification displays in QuarkXPress, click OK. 

 If a QuarkXPress user anchors a table in a text box with vertical story direction and assigns the 
text box as an article, the table is not maintained when a QuarkCopyDesk or QPS Web Hub user 
checks in the article. (467250) 

http://support.quark.com/knowledgebase/searchknowledgebase.aspx
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 QuarkCopyDesk with QPS XTensions software 

 A QuarkCopyDesk article window changes size and position on screen after a QuarkCopyDesk 
user acknowledges an updated geometry notice from QuarkXPress. (464541) 

 (Mac OS only) Overflow text to which you apply group characters does not display correctly in 
Galley view. (467044) 

QPS Web Hub 

 If you import a PDF into a picture box and set it to display a page other than page 1, check in the 
picture box as part of an article, and then open the article in Web Hub, page 1 of the PDF 
displays. (49166) 

 If you open a text component in Firefox 3.6.9 or later and copy and paste text that contains an 
anchored item, rubi, a note, or grouped characters, the pasted text does not display in spread 
view and the changes are not saved when you check in the article. (56242) 

 After you open a text component for editing in Web Hub, if you move the dialog box, zoom in or 
out, click Apply, or apply a style sheet, the cursor disappears and changes to the text may be 
lost. (17773) 

 You can’t import a picture into a picture component if the picture file name contains any of the 
following characters: <>/& (23383) 

 (Windows only) In Internet Explorer’s Compatibility View, if you open a text component, place the 
text cursor in the second paragraph, and then apply a paragraph style sheet, the style sheet is 
applied to the first paragraph. (34584) 

Workaround: Select text in the second paragraph before applying the style sheet. 

 If you apply a Prevent Change constraint on Status B to a custom attribute, then try to check in an 
asset for which you’ve changed the status from Status A to Status B, an erroneous alert displays. 
(25063) 

 If you remove the paragraph return between two paragraphs that have different paragraph style 
sheets, the merged paragraph takes on the attributes of the second paragraph (in Firefox) or the 
attributes of the first paragraph (in Internet Explorer). (4044) 

 If you change the size of text so that it is different from the text size of the style sheet applied to 
the text, then assign the text as part of an article, then check the article out in Web Hub and 
check it back in, and finally update the article in QuarkXPress, the size of some invisible 
characters (such as line breaks) may revert to the size indicated by the style sheet, resulting in 
reflow. (34342) 

 If cookies are disallowed in the Web browser, Web Hub allows you to log on but then does not 
function properly. (4069) 

 If you group a table with a box, anchor the group in a text box, add text to the box until the 
anchored group overflows out of the box, assign the text box as an article, and then try to render 
the article with QuarkXPress Server, one of the following messages displays: "The item cannot 
be positioned off the page" or "Operation failed, one or more parameters are invalid." (13941) 

 (QPS Web Hub on Firefox or Internet Explorer) If a QuarkXPress user creates an article 
assignment that includes an applied style sheet, the style sheet formatting is discarded when a 
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QPS Web Hub user checks out the article, selects all text with a keyboard command or the 
Select All button, and begins typing. (459026) 

 When a check box or drop-down menu attribute has a constraint (such as “require change”), the 
constraint requirement displays in text in the Check In and Save Revision dialog boxes when a 
QPS Web Hub user clicks Check In or Save Revision, but the attribute is not highlighted in red 
in the attribute list in the Check In or Save Revision dialog boxes. (459234) 

 When you are using QPS Web Hub and you apply Rubi or Group Characters to a range of 
selected text that contains Rubi, Group Characters, anchored content, or notes, these elements 
are removed. (466949) 

QPS SharePoint Adapter 

 Some operations do not work correctly for QPS assets in Datasheet View, Gantt View, and 
Access view. (52718) 

 The SharePoint Manage Copies feature does not work for assets in a document library that is in 
the QPS Home library. (50924) 

 If the SharePoint Inline Editing feature is enabled for a SharePoint view in the QPS Home library, 
an erroneous alert may display if you try to discard checkout of a picture or check in a checked-
out picture. (50905) 

 If you select Explorer view (Library > Open with Explorer) in a QPS library, you can make 
changes to assets that are not checked out, and the changes are not reflected in SharePoint. 
(55822) 

 When you are assigning assets to QPS in SharePoint, QPS does not automatically retain the last-
used Status, Workflow, and Routed To values from one check-in to the next. (57602 

 If you add a domain user with a name that contains special characters (such as accented 
characters), then try to create a repository with a name that contains special characters, an 
erroneous alert displays and you cannot create the repository. (59811) 

QPS XTensions XDK 

 Only one of the three TaskPaneExtensibility plugin samples can be loaded at a time. (57296) 

 The Checkin feature of the CheckinCommandsLayer (in UIACCESSLayer) causes an 

unexpected quit if the UI is suppressed. (58249) 

Workaround: Check in a sample project before calling this feature, or use the feature without the 
UI suppressed.  

 The function xt_GetCurrentUserInfo is not documented in the QDR. (34327) 

QPS Alfresco adapter 
To install QPS Connect Client 8.1.6.0 components for Alfresco on Mac OS: 

1. Control-click the QPS Connect Client application icon and choose Show Package Contents. 
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2. Open the “Contents” folder. 

3. Open the “PlugIn”s folder. 

4. Copy the "AlfrescoPlugin.plugin" file to the “PlugIns” folder. 

Resolved Issues: QPS 8.5.1 
Following is a list of issues resolved in QPS 8.5.1. Note that the following is not an exhaustive list of all 
fixes in this version. 

QPS Server 
 RESOLVED: When you import users from LDAP or Active Directory, any user names that are 

longer than 20 characters are truncated to 20 characters. (53545) To avoid this issue, open the 

conf/LdapConfig.properties file (in the QPS Server application folder) and set the 

following values for these parameters: 

user.attribute.name=userPrincipalName 

user.searchfilter=(userPrincipalName=*) 

user.attribute.name.for.authentication=samaccountname 

 RESOLVED: If you call the getStatusByName() function with an Oracle database, QPS Server 

throws an unhandled server exception. (80385) 

 RESOLVED: If you update QPS from 8.1.6, QPS Server does not parse some Job Jackets that 
have UTF-8 encoding. Consequently, no Job Jackets display in QPS Connect Client when you 
edit a collection. (78623) 

QPS Clients 
 RESOLVED: Users can create and execute searches even if they don’t have the privileges to do 

so. (39958) 

 RESOLVED: In QPS Connect Client and Web Hub, changing the status of an asset sometimes 
changes the Route to value even if no auto-routing rule applies.(44229) 

 RESOLVED: If QPS is running with https, you cannot get PDF and SWF files from QPS clients. 

(83061) 

QPS Connect Client 
 RESOLVED: QPS client applications sometimes unexpectedly quit if you scroll through assets in 

filmstrip view. (66393) 

 RESOLVED: (Windows only) There is no way to change the font and size used for attribute 
values to a font other than the default search palette font. (74220) To change this font and size, 
add the following key to the <appSettings> section of the “QPS Connect Client.exe.config” file, 

with the desired font and size in the “value” attribute: <add key="FontName_Text Preview" 
value="Arial, 18"/> 

 RESOLVED: (Mac OS only) There is no way to configure QPS clients to remember the user 
name but not the user password between logins. (37970) To configure this option for 
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QuarkXPress, QuarkCopyDesk, or Quark Connect Client, Option-click the application icon and 
choose Show Package Contents. In the window that displays, navigate to 

Contents/Frameworks/QPPCore.framework/Resources, open the “QPPCoreConfig.plist” 

file in a text editor, and set the <string> value of the RememberPassword key to 1 to 

remember both the user name and the password when Remember Me is checked, or 0 to 
remember only the user name. The default value is 1. 

QPS XTensions Software 
 RESOLVED: Text formatting changes when you copy and paste it between articles, even if those 

articles have the same resources (style sheets, H&Js, colors, etc.). (42467) 

 RESOLVED: If you check out an assigned article in QuarkCopyDesk, make a text component 
overflow, check the article back in, and then attach the article to a project, a new text box is 
created for the overflow text. (51182) 

 RESOLVED: (Windows only) If your Windows user name contains East Asian characters, you 
cannot create an article from a Job Ticket. (67850) 

 RESOLVED: If you try to replace an invalid picture with a different picture, QuarkXPress 

unexpectedly quits. (69639) 

 RESOLVED: Command+A/Ctrl+A does not select all assets in the Workspace Browser window. 
(73273) 

 RESOLVED: (Windows only) In a new project, if you create a spot color using one of the supplied 
color models (such as PANTONE, TOYO, and DIC), apply that spot color to text in a text box, and 
assign the text box as an article, the project loses its relationship with the article. As a result, the 
article does not display in the Project Attachments palette and the Attachments tab of the 
Search Results palette, and QuarkXPress may unexpectedly quit when you use QPS features. 
(31460) 

 RESOLVED: If you change the focus in the Navigation pane, layout-specific buttons (such as 
Assign, Detach, and Update) become disabled, even if an item is selected in the layout. (52281) 

 RESOLVED: If you check out a read-only copy of a library and then quit QuarkXPress, the library 
is not deleted from the computer. If you then relaunch QuarkXPress and try to check out the 
same library in read-only mode, QuarkXPress unexpectedly quits. (65456) 

 RESOLVED: Audio alerts in QuarkXPress and QuarkCopyDesk don't work if the Dialog Box 
Alerts preference is unchecked, even if the Audio Alerts preference is checked 
(QuarkXPress/Edit > Preferences > Quark Publishing System > General > Notification 

pane). (68286) 

 RESOLVED: (Mac OS 10.5.x only) If you quickly select back and forth between various assets in 
the Workspace Browser palette’s Preview pane, without allowing those assets’ previews to load 

completely, QuarkXPress and QuarkCopyDesk sometimes unexpectedly quit. (81150) 

 RESOLVED: If you lose the connection with QPS Server in such a way that the logoff alert does 
not display, QuarkXPress unexpectedly quits when you close the Workspace Browser window, 

and you are not logged off. (82745) 

 RESOLVED: If you check out a project and assign an article from the project or attach an article 
to the project, then another user starts editing the project’s attributes, and then you cancel the 
checkout of the project, the boxes that were assigned incorrectly remain flagged as having 
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attachments. If you subsequently try to delete or assign pictures to these boxes, QuarkXPress 
may unexpectedly quit. (59676) 

 RESOLVED: Iif you assign an article with more than 100 components, the exception 
"HTTP_TRANSPORT_EXCEPTION" (Mac OS) or "Operation Timed Out" (Windows) occurs. 
(59674) 

QPS Web Hub 
 RESOLVED: If you log in to QPS Server with a user name that includes an apostrophe or 

quotation marks, you cannot checkout an article. (61345) 

 RESOLVED: The Status and Route to fields are enabled in the Check-In dialog box even if you 
don’t have the privileges necessary to access these fields. (68309, 29754) 

QPS SharePoint Adapter 
 RESOLVED: You cannot use legacy assets if you migrate from using a file system repository to 

QPS 8.5 with a SharePoint repository. (83485) 

 RESOLVED: If you install SharePoint on a Windows 2008 R2 domain controller computer, you 
cannot define SharePoint as a QPS repository. (58149) 

 RESOLVED: If you change the password of the domain user under which a SharePoint 
Repository was set up, the SharePoint repository becomes unavailable and cannot be made 
available again. (63565) 

 RESOLVED: You cannot delete a repository if its status becomes invalid for any reason (for 
example, if SharePoint is down). (65365) 

 RESOLVED: The name of a SharePoint repository cannot begin with any of the following 

characters: # % & * _ : " < > . ? / { } | \ ~. (68181) 

 RESOLVED: The name of a SharePoint repository cannot contain accented characters. (59815) 

 RESOLVED: When you are using SharePoint as a repository, if you assign a text component as 
a .docx file, check out and open the .docx file in QuarkCopyDesk, save a revision of the .docx file, 
and then try to update the content in QuarkXPress, the following error message displays: “Unable 
to Access the Repository that corresponds to this Asset Type.”(64819) 

 RESOLVED: If you upload a .docx file to SharePoint, check the file out, edit it, check it back in, 
assign it to QPS, and then try to check it out again, the following error message displays: “Unable 
to Access the Repository that corresponds to this Asset Type.” The same error message displays 
if you try to drag and drop the file into QuarkXPress. (64680) 

 RESOLVED: If SSL is enabled for the IIS installation under which SharePoint services are 

running, you cannot use SharePoint as an asset repository. (66340) 

 RESOLVED: If you create a document library in the QPS Home library, the Word document 
parser is disabled for that library. (55353) 
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QPS XDK 
 RESOLVED: The QPS 8.5 XDK (build 9262) package contains an old header file. The 

Client/Headers/AttributeTypes.h file erroneously contains getter and setter methods for 

PublicationID, SectionID, EntityID and EntityCategoryID. This results in linking errors, because 
these methods are no longer available as of QPS 8.5. 

 RESOLVED: The XTGetAttachedAssetInfo() function cannot detect a corrupted box. 

(69640) This function now sets XTAttachedAssetInfo.attachmentType to 

kAttachmentTypeNone if it cannot find the attachment information for a box. For a corrupted 

box, a value of ERR_INVALID_ATTACHMENT is returned if the user is logged into the server. 

Resolved Issues: QPS 8.5 
Following is a list of issues resolved in QPS 8.5. Note that the following is not an exhaustive list of all fixes 
in this version. 

QPS Server 

 RESOLVED: If a QPS Server computer has two or more IP addresses on separate networks, 
QPS Client applications may take up to two minutes to log on to QPS Server (depending on their 
network locations). (4060) 

 RESOLVED: If you click a publication or section in the Job Jackets® pane of the 
Administration pane in QPS Connect Client, a "JobJacket Not Found" exception is logged. 
(12469) 

 RESOLVED: Domain user names that are longer than 20 characters are truncated if you import 
them via LDAP. (53545) 

 RESOLVED: You cannot use thumbnail previews, copytasting, and full-text search with .docx 
files. (40497) 

 RESOLVED: An error occurs if you try to launch the QPS Server console on a 64-bit computer 
running Mac OS 10.6.x. (32033) 

 RESOLVED: If QPS Server is running behind a firewall, you must open ports 61400–61407 to 
work with QPS clients outside the firewall. (444776) 

 RESOLVED: If a computer has more than one IP address, you must add all of the computer’s IP 
addresses to the “ServerApp.properties” file. 

QPS Connect Client 
 RESOLVED: When importing users from LDAP, you can see only their usernames. (30612) 

 RESOLVED: Attributes defined at the server level are not available when designing forms for 
specific asset types. (33343) 

 RESOLVED: In QPS Connect Client, you cannot check in QuarkXPress projects and 
QuarkCopyDesk articles using the Check In Other command or by dragging them into QPS from 
the file system. (48194, 48198) 

 RESOLVED: The Route To drop-down menu cannot display users’ first and last names. (19010) 
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 RESOLVED: When you check in an asset, the Status and Route To values default to those used 
for the asset that was last checked in. (8797, 44563) 

 RESOLVED: You cannot get a layout or article as a PDF in QPS Connect Client. (37966, 53505) 

QPS XTensions Software 

 RESOLVED: If you import a picture, enable Full Res Preview for the picture (Item > Preview 
Resolution > Full Resolution), check the article or project in, and then check the article or 
project back in, an alert displays, erroneously indicating that you are trying to replace a picture. If 
you click Continue, the picture is detached from the article or project. (9099) 

 RESOLVED: (Mac OS only) If you duplicate a library in QPS, QuarkXPress cannot open the copy 
of the library. If you Get a library, the library will open but is empty. (20346) 

 RESOLVED: Full Resolution settings for pictures (View > Full Res Previews and Preview 
Resolution > Full Resolution) do not work in QuarkXPress for images attached from QPS 
Server. (449723) 

 RESOLVED: QuarkXPress and QuarkCopyDesk stop responding if the network connection fails 
while they have a project or article checked out. (49446) 

 RESOLVED: You can use drag and drop to replace a QPS picture in a layout even if the picture 
has a formatting lock applied to it. (49020) 

 RESOLVED: By default, a picture box’s runaround is Item. If you draw a picture box on top of a 
text box, then attach a text component to the text box and a picture component to the picture box, 
the picture box’s runaround changes to None. (44240) 

 RESOLVED: If you create two text boxes named “Body 1” and “Body 2”, assign them as an 
article, and then try to change the component name of the first text box to “Body 2”, the 
application allows the change despite a warning alert, and then the article becomes locked.  
(41952) 

 RESOLVED: (Mac OS only) If you save a revision of an attached article that has a picture 
component attached to it, the size of the article file increases unnecessarily,  If you then update 
the content of the project to which the article is attached, the size of the project file increases 
unnecessarily. (30744) 

 RESOLVED: If you attach a third-party text file to a layout, the Page Picture setting in the 
Assign dialog box changes from All Pages to No Pages. (17246) 

 RESOLVED: Some QPS menu items sometimes display in the wrong language. (18201) 

 RESOLVED: No alert displays if you check in a fast-saved Word document and attach it as an 
article component. (26493) 

 RESOLVED: If you anchor a text box into a story that spans more than one box and then attempt 
to duplicate the layout, QuarkXPress unexpectedly quits. (27154) 

 RESOLVED: If you import a picture into a picture box, assign the picture box as an article or a 
picture component in an article, check out the picture with the Edit Original command, edit the 
image, check the picture file back in, and then export a PDF of the layout, the PDF does not show 
the changes to the image. (43990) 
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 RESOLVED: If you draw a text box across both pages of the last spread in a project with a 
vertical story direction, and you assign that picture box as a picture or article, the attachment fails 
and you can delete the box in the layout. (48906) 

 RESOLVED: In a layout with more than one layer, if you make the Default layer active and then 
drag-and-drop an article template onto the layout, the stacking order of the items changes (Mac 
OS) or QuarkXPress unexpectedly quits (Windows). (49445) 

 RESOLVED: QuarkXPress and QuarkCopyDesk unexpectedly quit when you try to exit the 
application (49529). 

 RESOLVED: If you create an article from a section that has a lot of style sheets, delete half of 
them, save the file as a template, and then check the template into QPS, the deleted style sheets 
come back. To avoid this issue, choose Never from the Update Job Jackets Resources drop-
down menu in the Article pane of the Preferences dialog box.(38755) 

 RESOLVED: If the QPS XTensions for QuarkXPress > Redlining > Accept and Reject 
Changes privilege is not checked for your role, you cannot create grouped characters and rubi in 
a vertical story. (Note that if text has Redline tracking, you must accept the changes before you 
use grouped characters and rubi with that text.) 

QPS Web Hub 

 RESOLVED: If you use QuarkXPress to update the geometry of an article twice while a user has 
the article open in QPS Web Hub, and the Web Hub user does not click Update Geometry the 
first time the article is updated, a second geometry notification displays and an unknown 
exception is thrown. (13263) 

 RESOLVED: There is no separator between users and groups in routing drop-down menus, and 
groups are not always listed before users. (31583) 

 RESOLVED: There is no way to import styled content as plain text. (51616) 

 RESOLVED: When the program language is set to French, the wrong message displays when 
you close the edit picture dialog box. (53056) 

 RESOLVED: There is no list view for templates and pictures. (55773) 

 RESOLVED: Backslash characters are duplicated when you edit text in Web Hub. (53095) 

Resolved Issues: QPS 8.1.6.2 
Following is a list of issues resolved in QPS 8.1.6.2. Note that the following is not an exhaustive list of all 
fixes in this version. 

QuarkXPress with QPS XTensions software 

 RESOLVED: (Mac OS 10.6.x only) QuarkXPress unexpectedly quits when you try to cancel the 
check-out of an article from the QPS menu. (11504) 

 RESOLVED: In a project that has corrupted color trapping resources, the following issues can 
occur: 
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o RESOLVED:  If you assign a box as an article template from a project, then attach that 
article template to the same layout, QuarkXPress sometimes unexpectedly quits. (40519) 

o RESOLVED: If you assign an article from QuarkXPress, open it in QuarkCopyDesk, 
update the geometry of the article in QuarkXPress, and then accept the geometry update 
in QuarkCopyDesk, QuarkCopyDesk sometimes unexpectedly quits. (40618) 

o RESOLVED: If you open a project, assign a text box as an article, check the project in, 
check out the article in QuarkCopyDesk, make some changes and check the article back 
in, then check out the project in QuarkXPress, check out the article in QuarkXPress, and 
finally check the article back in, QuarkXPress sometimes unexpectedly quits. (40629) 

o RESOLVED: QuarkXPress sometimes unexpectedly quits when you assign an article to 
boxes that were dragged into the layout from a library. (40350) 

 RESOLVED: If you use QuarkCopyDesk to change the attributes (for example, scaling or 
position) of a picture in a picture component, then update the picture component in QuarkXPress, 
the updates do not display. Also, the QuarkXPress user can move and scale the picture in its box 
even while the picture component is not checked out. (42223) 

To address this issue, the following line has been added to the “ServerApp.properties” file. For 
more information, see the update instructions for QPS 8.1.6.2. 

allow.pic.formatting.without.article.checkout= No 

 RESOLVED: In some projects, QuarkXPress may unexpectedly quit if you assign a text box as 
an article. (44321) 

QPS Web Hub 

 RESOLVED: You cannot check in article if Web Hub is loaded in an <iframe> element in Internet 
Explorer 6. 

 RESOLVED: Story depth shows as “NaN” if QuarkXPress Server is  running on a non-English 
OS. (42523) 

 RESOLVED: Decimal story depth values display with a period instead of a comma in the French 
and German program languages. (34981) 

QPS Alfresco Adapter 

 RESOLVED: You cannot search on a custom date type attribute in an advanced search. (38822) 

Resolved Issues: QPS 8.1.6.0 
Following is a list of issues resolved in QPS 8.1.6.0. Note that the following is not an exhaustive list of all 
fixes in this version. 

Installer and updater  

 RESOLVED: The updater does not install the latest version of the documentation. 
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 RESOLVED: (Mac OS only) In QPS Connect Client, choosing Help > QPS Connect Client Help 
displays the previous version of the Help. 

QPS Server 

 RESOLVED: (Windows only) QPS Console unexpectedly quits after you use it to start QPS 
Server on a 64-bit computer. (33697) 

 RESOLVED: On a QPS installation with an Oracle database, if you repeatedly run an automation 
profile that attaches a particular picture to a project, the profile will stop working after it assigns 
the picture to a large number of projects. (34765) 

 RESOLVED in Mac OS X 10.6.2: (Mac OS X 10.6 only) If a QPS Server instance that uses 
LDAP or Kerberos is running on a computer under Mac OS X 10.6 (Snow Leopard®), an invalid 
password error occurs when an LDAP or Kerberos user tries to log in. (11094) 

 RESOLVED: If a logged-in instance of QuarkXPress or QuarkCopyDesk unexpectedly quits, the 
user’s session still displays in the QPS Connect Client’s User Activity screen until you log off 
and log on again in QPS Connect Client. (27944) 

QPS Connect Client 

 RESOLVED: Projects and articles do not appear in the correct order in the Search Results 
palette when sorted by First Page. (4064) 

 RESOLVED: You cannot set Role/Status privileges on a system attribute without overwriting the 
name of the attribute in the selected language. (28501) 

 RESOLVED: (Windows only) The tab order for controls in the Edit Attributes dialog box is 
incorrect. (16913) 

QPS XTensions software 

 RESOLVED: If you create an article template in a non-publication project, and then create an 
article from that article template in QuarkCopyDesk, QPS erroneously indicates that article 
preferences have been updated. (9097) 

 RESOLVED: When the program language is Spanish, some QuarkCopyDesk preferences 
display in Dutch. (12909) 

 RESOLVED: When the program language is set to French, if you attach a picture from the 
Search Results palette, the word “OK” is incorrectly translated in the resulting dialog box. 
(14456) 

 RESOLVED: If you insert an anchored picture box with a local picture into a new text box, assign 
the text box as an article, and then copy and paste the text box, you cannot assign the anchored 
picture box in the pasted text box. (17435) 

 RESOLVED: If you click the default name of a component in the Component tab of the Modify 
dialog box (Item menu), then click OK without changing the component name, QuarkXPress 
subsequently fails to increment the number in the default component name for new boxes of the 
same type.  (25740) 
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 RESOLVED: If you select the Text Unlinking tool, click the second of two linked boxes 
containing a QPS article, and then Shift+click the first box, the text moves to the second box, but 
the second box becomes uneditable and undeletable. Note: You can no longer unlink two boxes 
containing a QPS article in this manner. (25983) 

 RESOLVED: In a checked-out project that contains a checked-out picture, if you check the 
picture back in and change its name during check-in, the picture name is incorrect in the project 
(Utilities > Usage > Pictures). (30813) 

 RESOLVED: QuarkXPress unexpectedly quits if you do the following: (33380) 

1. Import a Job Jackets file in QPS Connect Client and assign it to a particular main 
category. 

2. Set the program language to German (Edit > Program Language > German). 

3. Create a project with one text box and check it in to QPS. 

4. Check the project out of QPS. When the Job Jackets dialog box displays, click Update. 

5. Assign the text box as an article. 

6. Change the geometry of the text box. 

7. Without saving, quit QuarkXPress. When the dialog box displays, click Check In. 

8. When the Update Story dialog box displays, click Update All. 

9. Click OK. 

 RESOLVED: If you create a project, add a text box with an anchored item, assign the text box as 
an article, and then make a copy of the text box, the anchored item in the copy is locked. (33546) 

 RESOLVED: If you Shift-delete a box with an attached article, the box is deleted even if you do 
not have the privileges “Detach components from project” and “Detach pictures from project,” and 
the article still displays as attached in the Search Results palette.  If you then try to check out the 
article, QuarkXPress may stop responding (Mac OS) or show an alert each time you try to use a 
QPS function. (26852). 

 RESOLVED: If you drag a multi-component article that uses default component names to 
multiple selected boxes so that the Map Component to Boxes dialog box displays, the boxes’ 
component names and types do not display in the Box drop-down menu. Note: QuarkXPress 
now highlights whichever box is selected in the Box drop-down menu. (25064) 

 RESOLVED: If you log in to QPS with QuarkCopyDesk, check out an article last saved in 
QuarkCopyDesk 7.x, and choose Edit > Notes > Open All Notes, the notes show as having 
been created by the current user, regardless of who actually created them. (33178) 

 RESOLVED: If you check out or save a revision of a library, close the library palette, log off, log 
back on as a different user or to another server, and then attempt to open the library file, the 
“environment conflict” alert displays, but the library opens anyway. (16680) 

 RESOLVED: If you press Option/Alt and drag a third-party article (such as a Word document or 
text file) onto a box with an attachment, QuarkXPress displays a Check In dialog box but does 
not create an attachment. On Mac OS, QuarkXPress may also unexpectedly quit. (28315) 

 RESOLVED: When you close a read-only copy of a library, the library file is not removed from the 
local folder. (18340) 
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 RESOLVED: If you create an article from two boxes on opposite pasteboards, then drag the 
article onto the left pasteboard in a different layout, the spacing between the boxes is not 
preserved. (25103) 

 RESOLVED: If you get a read-only copy of a library, log off of QPS, and then log back on to 
QPS, you can check in the read-only copy of the library. (19074) 

QPS Web Hub 

 RESOLVED: If you copy and paste text from Web Hub or another application into Web Hub, 
check the article in, and then check the article back out, several problems can occur. Paragraph 
returns in the pasted text can be converted to soft returns (and fail to display in Web Hub), and 
extra soft returns can be added. To avoid this issue, use the new Import Text feature. Note that 
when you use Import Text, all content in the component is replaced. (4055, 8316) 

 RESOLVED: If you use the <Ask> option in a search, Web Hub does not honor your selection for 
asset type. (34449) 

 RESOLVED: Story depth is not displayed in Web Hub. (14848) 

QPS Script Manager 

 RESOLVED: (Windows® only) If Java 1.6 is installed, the Log On dialog box does not close 
when you click Log On, and the QPS Script Manager window does not display. Each time 
someone clicks the Log On button, though, a user session is created in QPS Server. This issue 
occurs randomly and is the result of a Java problem (see 
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6544857). (7790) 

XDK 

 RESOLVED: The QDR does not contain documentation for library support and for the Article 
Shapes feature.  

Resolved Issues: QPS 8.1.4.0 
Following is a list of issues resolved in QPS 8.1.4.0. Note that the following is not an exhaustive list of all 
fixes in this version. 

QPS Server 

 RESOLVED: QPS Server does not remove temporary files for which indexing has failed from the 

C:\WINDOWS\Temp folder. (17046) 

 RESOLVED: Making an RMI call to PreferenceService results in an  
UNHANDLED_SERVER_EXCEPTION. (18965) 

 RESOLVED: (Mac OS only) The Start automatically when machine reboots feature in QPS 
Server Console does not work in QPS 8.1.3.0. (26428) 

http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6544857
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 RESOLVED: In Project and Page view, QPS shows page numbers in alphabetical order rather 
than numeric order. (27914) 

 RESOLVED: Searches of the File Name Extension, Check-out Application and Check-out 
Machine Name attributes are case-sensitive if you are using an HSQLDB database. (22338) 

QPS Database  

 RESOLVED: The Drop script cannot drop the QPP_RENDITION_TYPES table for Oracle. 
(27851) 

QPS XTensions software 

 RESOLVED: If you attach a PDF to a picture box and specify a page other than 1, page 1 
nevertheless sometimes displays in the picture box. (13902) 

 RESOLVED: If you create a facing-page layout with two pages, add a box with a colored 
background and a text box with overflow to the second page, and then assign the boxes as an 
article with a page picture, the page picture is shifted onto the pasteboard in the resulting article. 
(19825) 

 RESOLVED: Saved searches do not display in the correct order in the QPS > Saved Searches 
submenu. (18357) 

 RESOLVED: If you try to delete a box with an attachment, an alert asks you to detach the 
attachment first. (You can now press Shift+Delete/Shift+Backspace to detach and delete without 
an alert.) (12767) 

QPS Connect Client  

 RESOLVED: QPS Connect Client does not work on 64-bit Windows computers. (22270) 

 RESOLVED: For files checked in in QPS 8.1.4.0, Hangul file names do not display correctly in 
the Search Results palette’s Original File Name field on Windows if the files were checked in 
from a Mac. (14712) 

QPS Web Hub  

 RESOLVED: Preview generation in Web Hub is very slow for projects that use a lot of anchored 
boxes if StyleSheetDeconstructSXT XTensions software is installed for QuarkXPress Server. 
(27990) 

Resolved Issues: QPS 8.1.3.0 
Following is a list of issues resolved in QPS 8.1.3.0. Note that the following is not an exhaustive list of all 
fixes in this version. 
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QPS Client 

 RESOLVED: You cannot move a picture asset from one main category to another without 
detaching it from any layouts to which it has been attached. (16710) 

 RESOLVED: If the “Change Picture Name when Attaching it to a Project” privilege is disabled for 
a user, that user can change the names of main categories and subcategories (even if the user 
does not have the privileges required to do so). (16601) 

 RESOLVED: The Status and Route To fields are available in QPS Web Hub even if a user’s 
privileges indicate that they should not be editable. (14578) 

 RESOLVED in Mac OS X 10.6.x: Displaying a thumbnail version of some pictures causes QPS 
client applications to unexpectedly quit. (474997) 

 RESOLVED: If your privileges prevent you from changing the Routed To attribute, the error 
message “The value for this Attribute cannot be changed” can display when you check in a file 
even if the Routed To value is changed automatically as a result of server rules (for example, if 
you change the Status attribute).  (16577) 

QPS Connect Client 

 RESOLVED: You cannot disable the “Accessibility services are not enabled” alert that displays 
when you launch QPS Connect client. (To disable this alert, set QPSDisableAccessibiltyWarning 
to 0 or NO in the QPPSearch.plugin's "info.plist" file.) (14925) 

 RESOLVED: (Mac OS only) You cannot check in a file with the suffix “.c” (used by the DCS file 
format) with QPS Connect Client. (14716) 

 RESOLVED: Archiving does not work if a main category, subcategory, or asset has a special 
character such as “/” in its name. (14314) 

QPS XTensions Software 

QuarkXPress with QPS XTensions software 

 RESOLVED: You cannot drag and drop a picture from a Search Results palette into an 
anchored box. (Note that even in QPS 8.1.3.0, you still cannot drag and drop a picture into an 
anchored box that is part of an article component.) (22258) 

 RESOLVED: If you assign an article from a picture box in QuarkXPress, check out the article in 
QuarkCopyDesk, import a picture, save a revision of the article, save a revision of the project, 
and then update the article content in QuarkXPress, the picture may not be displayed. (20396) 

QuarkCopyDesk with QPS XTensions software 

 RESOLVED: If you use QPS XTensions software for QuarkCopyDesk 8.1 to check in a new 
article that contains a picture component, you cannot change the attributes of the picture. (19041) 

 RESOLVED: Text entry is slow in QuarkCopyDesk. (19657) 
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 RESOLVED: QuarkCopyDesk unexpectedly quits with the error message 
“KERN_PROTECTION_FAILURE in CNotificationMessageBase::GetNotificationGroupId.” 
(20072) 

QPS Web Hub 

 RESOLVED: Performance is slow when editing a long multipage article with many images in 
QPS Web Hub. (16737) 

 RESOLVED: Performance is slow when editing a long multipage multicomponent article in QPS 
Web Hub. (16737) 

QPS Alfresco Adapter 

 RESOLVED: (Alfresco Adapter only) If you change the name of a main category after that main 
category has been set up with a content store in Alfresco, the name of the Alfresco content store 
changes and the assets in that content store become unavailable. (16709) 

 RESOLVED: (Alfresco Adapter only) (8.1.0.1) If you change the name of a main category after 
that main category has been set up with a content store in Alfresco, the name of the Alfresco 
content store changes and the assets in that content store become unavailable. (16709) 

Resolved Issues: QPS 8.1  
Following is a list of issues resolved in QPS 8.1. Note that the following is not an exhaustive list of all fixes 
in this version.  

QPS Server 

 RESOLVED: You cannot import users from Netscape® Directory Server 4.1. (4083) 

 RESOLVED: The performance of several operations in QuarkXPress and QuarkCopyDesk 
(creating a new publication project, assigning an article, updating the geometry of an article, and 
updating the content of an article) has been dramatically improved. (447771) 

 RESOLVED: An error can occur if you try to view the revisions of a project or article that has a 
large number of revisions. 

 RESOLVED: QPS Server erroneously translates hostnames in the “server.additionalnames” file 
into IP addresses. (474749) 

 RESOLVED: If you open the “log4j.xml” file and change the location of a log file to an absolute 
path, the log file does not open when you click View Log in the console. (4063) 

 RESOLVED: Users’ Search Results palettes sometimes stop updating. (10814) 

 RESOLVED: If you have a large number of saved searches that are shared with many users, and 
you delete or unshare several of these searches at the same time, the server becomes 
temporarily unresponsive. 
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 RESOLVED: After you restart QPS Server, all characters with umlauts are replaced with other 
characters. 

 RESOLVED: You cannot build nested (complex) searches that match a particular condition or 
search.. (12896) 

QPS Server API 

 RESOLVED: You cannot use the QPS API to import a QuarkXPress project or QuarkCopyDesk 
article. (4048) 

 RESOLVED: When using the Java™ Server API, an ASSET_LOCKED_BY_OTHER exception 
can be thrown even if the asset in question is locked by the active user session. (4078) 

 RESOLVED: You cannot create a privilege group at the root level with 
privilegeGroupService.createPrivilegeGroup(). (473041) 

 RESOLVED: You cannot edit custom privileges for the Administrator userClass. (473042) 

 RESOLVED: The NUMBER_OF_PAGES attribute can now be modified by clients. (15684) 

QPS Client 

 RESOLVED: You cannot group and sequence AND/OR operations in a search. (4045) 

 RESOLVED: Date fields do not support autocompletion. (4070) 

 RESOLVED: Users whose privileges allow them only to archive assets can do other things in the 
QPS Connect Client Administration pane. (4093) 

 RESOLVED: If you select multiple assets routed to No One in multiple publications and sections 
and try to edit their attributes, an exception is thrown. (473313) 

 RESOLVED: (Windows only) The New Search button is unavailable for users who are not 
administrators. (474544) 

 RESOLVED: When you view all revisions of an asset, the revision comments do not display by 
default. To resolve this issue: (473439) 
Mac OS: In the QPS Connect Client, QuarkXPress, and QuarkCopyDesk application folders, 

open the file [application 
name].app/Contents/Frameworks/QPPCore.framework/Frameworks/QPPAssetComm

ands.framework/Resources/info.plist, locate the 

<key>QPSExpandAllRevisionComments</key> element, and set the following <string> 

value to 1. 

Windows: Open the file “[application name].exe.config” (in the QPS Connect Client, 
QuarkXPress, and QuarkCopyDesk application folders) and add the following: 
<!-- ViewAllRevisions take the values 0 or 1.--> 

<add key ="QPSExpandAllRevisionComments" value="1"/> 

 RESOLVED: There is no way to search for assets routed to No One. (You can search for assets 
routed to No One by searching for Routed to = is not defined.) (8515) 
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 RESOLVED: The tooltips for the Check In Other button are incorrect when the toolbar is in Icon 
& Text mode and in the Customize Toolbar dialog box. (10885) 

 RESOLVED: If you duplicate or delete an InCopy assignment (.inca) article asset, the linked .incx 
asset is not duplicated or deleted. 

QPS XTensions software 

 RESOLVED: If you choose QPS > Go To Assignments, a new Search Results palette displays 
even if you already have an assignments tab in an open palette. (4068) 

 RESOLVED: If you synchronize content (but not formatting) for two text boxes in QuarkXPress, 
check one of them into QPS as an article, and then change the formatting of the text in the article 
with QuarkCopyDesk, the formatting of the text in the other box changes too. (4053) 

 RESOLVED: Performance is sometimes slow compared to earlier versions of QPS. (4218, 4219, 
4220) 

 RESOLVED: If you import an EPS file with a low-resolution preview, assign the picture as a 
picture file, and then print the page to a non-PostScript® printer, the low-resolution preview prints 
instead of the full-resolution image. (474217) 

 RESOLVED: If you display a dialog box (such as the Check Out dialog box), and then leave that 
dialog box open while the server is shut down, the client application may stop responding when 
you close the dialog box. (4192) 

QuarkXPress with QPS XTensions software 

 RESOLVED: If you check out a project that uses a style sheet defined in the QPS Server Job 
Jackets file, and that style sheet uses a non-default color, a duplicate of the style sheet with “*” 
appended to the name is created when you synchronize the project with the server Job Jackets 
file. (4073) 

 RESOLVED: If you position a drop-shadowed picture box on the pasteboard so that it overlaps 
the page shadow, then drop an article on a text box on the page, QuarkXPress may unexpectedly 
quit. (4074) 

 RESOLVED: The Save As command sometimes does not work properly for read-only or 
checked-out projects that use shared content or Composition Zones®. (474642, 474626) 

 RESOLVED: If you try to add a text box with a component name (Item > Modify > Component 
tab) consisting solely of digits as a component to an article that was created from a text box with 
the same name, QuarkXPress stops responding. (474264) 

 RESOLVED: If you change the component name for a box and then close the project without 
saving, the new name of the box is not saved. (472771) 

 RESOLVED: If you assign a picture in a picture box as a picture file and then export the layout in 
PDF format, QuarkXPress unexpectedly quits (Windows) or the picture does not print (Mac OS). 
(474218) 

 RESOLVED: You cannot drag and drop a picture or article into a box that was dragged into the 
layout from a library. (474576) 
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 RESOLVED: The Page Pictures setting reverts to the default setting each time you assign an 
article. (10697) 

 RESOLVED: If a library is open, QuarkXPress unexpectedly quits on exit. (3327) 

 RESOLVED: If you try to import an article containing an anchored text box or table into a text box 
in a layout, QuarkXPress unexpectedly quits. (7774) 

 RESOLVED: Updated runaround settings are not retained under the following conditions: You 
create a QuarkXPress project, create a QuarkCopyDesk article assignment that includes a 
picture with a runaround that affects text flow, and change the runaround setting to Same As 
Clipping (Item > Modify > Runaround tab > Type drop-down menu). If you update content for 
the article, the Same As Clipping setting is not retained, and the Type drop-down menu setting 
returns to Item.  

 RESOLVED: If you create an article with a picture component, check out the picture used in the 
component and reduce its dimensions, check the picture file back in, and then drag the article into 
a layout, the old (larger) version of the picture displays. (474502) 

QuarkCopyDesk with QPS XTensions software 

 RESOLVED: The QPS XT XTensions software fails to load with QuarkCopyDesk when you 
disable the RedLine.xnt XTensions software.  

 RESOLVED: If you create an article from an article template, attach it to a project, and then 
detach the article from the project, the article loses the geometry and defaults that were specified 
in the article template. (4062) 

 RESOLVED: If you link box 1 to box 2, assign the story as an article, link box 2 to box 1, delete 
box 1, check in the project, and then check the project back out, the article no longer displays in 
the Search Results palette but remains attached to the box and cannot be detached. (472991) 

 RESOLVED: If you check out an article that is linked to a project in WYSIWYG view, the window 
does not scroll automatically to the location of that article in the page picture. (11969) 

 RESOLVED: If you create an article with a semitransparent PSD file in QuarkXPress, check the 
article in to QPS, check it out in QuarkCopyDesk, and send the article to output, transparent 
areas in the PSD file display white in the output. (4084) 

QPS Web Hub 

 RESOLVED: Style sheets are not listed alphabetically in QPS Web Hub. (4072) 

 RESOLVED: QuarkXPress Server may unexpectedly quit during check-in or check-out if all 
logging options are checked (QuarkXPress Server > Server Configuration > Logging)  (4079) 

 RESOLVED: Zooming does not work properly if an article was empty when it was first assigned. 
(4216) 

 RESOLVED: If a component in a multi-component article contains a special character (inserted in 
QuarkXPress by choosing an option from the Utilities > Insert Character), you may not be able 
to check the article in after making changes to it. (473452) 
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 RESOLVED: If you apply a style sheet with tabs to a paragraph, override the style sheet’s tabs 
with locally applied tabs, assign the text box as an article, check the article out and then back in in 
Web Hub, and then update the article in QuarkXPress, the tab positions change. (471788) 

 RESOLVED: The Get as PDF and Get as SWF dialog boxes are not localized. (8156) 

 RESOLVED: Quick Search for names does not work for an asset with a name or content that  
contains East Asian characters. (8753) 

 RESOLVED: If a QPS Web Hub user checks out an article, copies a range of text that includes 
an anchored table, and pastes the text, the text cells in the table are empty, and the table cannot 
be edited in QuarkCopyDesk. (467805) 

Resolved Issues: QPS 8.0 
Following is a list of issues resolved in QPS 8.0. Note that the following is not an exhaustive list of all fixes 
in this version.   

QPS Server 

 RESOLVED: When the Job Jackets file for a QPS Server includes special characters in style 
sheet names (for example, umlauts, Å, Ä, ¶, ©, or $), these characters convert to other characters 
under the following conditions: A QuarkXPress user creates an assignment that includes the style 
sheets, a QuarkCopyDesk or QPS Web Hub user checks out the assignment but does not use 
the style sheets, and the QuarkCopyDesk or QPS Web Hub user checks in the article. (461324) 

 RESOLVED: If you display the Indexing Status column in a Search Results palette, search for 
a large number of projects and articles, and delete one of the articles or projects from QPS 
Server before the search completes, the search process unexpectedly quits. (467847) 

 RESOLVED: (Windows 2003, 64-bit) You cannot display QPS Server logs or the JConsole 
window when you install QPS Server on 64-bit versions of Windows 2003. (468926) 

QPS Script Manager 

 RESOLVED: (Windows Server 2003, Mac OS 10.4.11) If you use the XML-generating sample 
scripts included with QPS Script Manager, the system alters article and project file names if the 
original file name includes special characters (for example, à, é, î, õ, and ü). (468496) 

QPS Connect Client 

 RESOLVED: (Mac OS) Only the default “Admin” user can change the Admin user password. 
(468888) 

 RESOLVED: QPS Connect Client does not work correctly on 64-bit versions of Windows Vista. 
(469433) 

 RESOLVED: If a subcategory name contains more than 12 characters, two tooltips display when 
a user moves the cursor over the subcategory name in the Administration: User Profiles 
window. (469798) 
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 RESOLVED: (Mac OS) The QPS Connect Client standalone installer specifies read-only 
permission, which prevents users from launching the application after installation. (467625) 

 RESOLVED: The German translations for “First Page Component” and “Last Page Component” 
are incorrect in the Administration: Attributes window in QPS Connect Client. (470207) 

 RESOLVED: The German translation for “Revisions Created” is spelled incorrectly in the 
Administration: Attributes window in QPS Connect Client (Asset Type > All). (470208) 

 RESOLVED: The German translations for “Change Unattached Article Name on Check-in” and 
“Tasting in Search Results Palette” are incorrect in the Administration: Roles and Privileges 
window in QPS Connect Client. (470209) 

 RESOLVED: The German translation for the “Date Modified” column is incorrect in the 
Administration: Job Jackets window in QPS Connect Client. (470211) 

QuarkXPress with QPS XTensions software  

 RESOLVED: Picture status in a QuarkXPress project (Utilities > Usage > Pictures) changes to 
Missing or No Disk File under the following conditions: You drag and drop a picture file from a 
Search Results palette, click Assign a Picture File, and change the assignment to be a 
QuarkCopyDesk article using the same file name. A file name-conflict alert displays. If you cancel 
the operation and then choose Utilities > Usage > Pictures, the picture status displays Missing. 
If you click OK in the conflict alert, the picture status displays No Disk File. (465607) 

 RESOLVED: The default button selection for the alert that displays when you open a 
QuarkXPress project that contains resources that do not match the QPS Server Job Jackets 
definition is incorrect. (438731) 

 RESOLVED: (Mac OS) “Print” is translated incorrectly in the QuarkXPress Preferences dialog 
box (QuarkXPress > Preferences > Quark Publishing System > General > Notification > 
Article Status Notification area). (470305) 

 RESOLVED: When you use QuarkCopyDesk to add an article component to an attached article 
that was assigned in a third-party format (and you update QPS Server through the Check In or 
Save Revision commands), the component does not display in the Project Attachments palette 
in QuarkXPress. (460293) 

 RESOLVED: (Windows XP) If you create a QuarkCopyDesk article from a text box in 
QuarkXPress, draw another box and link it to the assignment text box, check out the article in 
QuarkXPress, add text until it flows into the linked box, and cancel the article checkout, the 
additional text appears to remain in the linked box. (463571) 

 RESOLVED: (Mac OS only) A checked-out QuarkXPress project that contains an umlaut in the 
file name is not deleted from your computer when you check in the project or cancel the 
checkout. Also, the project file name is changed, which creates a conflict when you attempt to 
display it by double-clicking the project in a Search Results palette. (452440) 

 RESOLVED: When a QuarkXPress user drags a picture file from a Search Results palette to an 
open area in a QuarkXPress project, a picture box is not created and the picture is not attached. 
(465139) 

 RESOLVED: Previews for the bounding boxes of Bézier, Freehand, and Starburst boxes in 
QuarkXPress projects that contain spreads or facing pages do not display in QPS Web Hub. 
Rectangular boxes display instead.  
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 RESOLVED: An alert displays incorrectly that warns of a QPS Server conflict and forces the user 
to close a non-QPS project under the following circumstances: (468312) 
 
A. A QuarkXPress user specifies an Auto Log Off interval (QuarkXPress/Edit > Preferences > 
Quark Publishing System > Auto Log Off). 
B. The user checks out a project and then opens a non-QPS project from his or her hard drive.  
C. The user allows the automatic log-off period to expire and is logged off of QPS Server.  
D. The user logs on again with the non-QPS project still open.  

 RESOLVED: Selecting text using multiple clicks in a QuarkXPress project is significantly slower 
than selecting text in non-QPS projects. (468506) 

 RESOLVED: When you use File > Save As to create a copy of a QuarkXPress project outside 
QPS, text boxes that had contained assigned QuarkCopyDesk articles remain locked and cannot 
be edited when you open the non-QPS project. (470271) 

 RESOLVED: Custom character and paragraph attributes do not display for secondary 
attachments of QuarkCopyDesk articles. (467290) 

QuarkCopyDesk with QPS XTensions software 

 RESOLVED: If a QuarkCopyDesk user reverts to a previous revision of an article that contains 
one or more anchored boxes, the anchored boxes do not display in Full Screen or Galley view. 
(463905) 

 RESOLVED: When a QuarkCopyDesk user checks out an attached article that contains notes, 
logs off of QPS Server, and chooses Edit > Note > Open All Notes, the article becomes locked 
and cannot be edited. (469071) 

 RESOLVED: The default button selections for the following dialog boxes are inconsistent in the 
Mac OS and Windows versions of QuarkCopyDesk: Cancel Checkout alert, Close (unmodified 
article), Close (modified article), New From Subcategory dialog box, Assignment Notification 
alert, and Geometry Notification alert. (454971) 

 RESOLVED: (Mac OS only) When you choose German as the program language for 
QuarkCopyDesk, the mouse-setting preferences are labeled incorrectly (QuarkCopyDesk/Edit > 
Preferences > Quark Publishing System > General > Mouse Settings tab). The radio buttons 
for Check Out, File Information Dialog Box, and Read-only do not correspond to the actual 
behavior when you double-click an asset in a Search Results palette. (467241) 

 RESOLVED: When you paste text with applied style sheets into another QuarkCopyDesk article, 
the style sheet information is lost and does not display in the Style Sheets palette. (469784) 

QPS Web Hub 

 RESOLVED: QPS Web Hub users with the privilege to “Check Out Assets Assigned to Other 
Users” cannot check out articles routed to No One or to a group to which the user belongs. 
(467239) 

 RESOLVED: Style sheets that are included in the Job Jackets file for a QPS Server are not 
included in subcategory articles created with QPS Web Hub. (460103) 
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 RESOLVED: If a QPS Web Hub user checks out an article but clicks Check In and clicks OK to 
close the Check In dialog box before the article attributes fully load, the article remains checked 
out. (468811) 

 RESOLVED: Article components that users select in the Edit Attributes or Check In dialog 
boxes in QPS Web Hub are not highlighted. (467308) 

 RESOLVED: When QPS Web Hub users with German or French operating systems log on to 
QPS Server, they need to specify German or French (Edit > Program Language) each time they 
log on. (468802) 

 RESOLVED: Discretionary hyphens are not displayed in QPS Web Hub. (467700) 

 RESOLVED: QPS Web Hub users cannot edit articles that contain fonts that are not included in 
the QuarkXPress Server font-mapping rule list. (450276) 

 RESOLVED: When a QPS Web Hub user is editing a multiple-component article and clicks 
Apply Changes in a component that contains no text, text in another component no longer 
displays. (453712) 

 RESOLVED: Not all of the applied style sheets display when you check out an attached article in 
QPS Web Hub. (470093) 
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